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BidPoint  XL Preface  

A few words on performing the takeoff and estimate for construction activities: 

• Quantity Takeoff is performed by measuring certain items and then calculating the desired 
quantities from these measurements. 
 

• Estimating is applying costs to the quantities. 

Applying the estimated cost to the quantities is usually performed in either an Excel workbook or 
through a relational database estimating program.  We believe that organizing your takeoff quantities 
in Microsoft Excel, regardless of the software used for estimating, is often the easiest, most logical 
and best way to organize the takeoff for most contractors.  Measure with BidPoint and calculate 
quantities with Microsoft Excel.  Excel is not for everybody however; certain divisions of work, such as 
site excavation and some of the mechanical trades may be better served by performing the takeoff in 
trade specific, non-spreadsheet applications.  Overwhelmingly however, Excel is the number one 
application by far for both large and small contractors for documenting takeoff quantities. In addition 
to the takeoff, Excel also has the largest market share among contractors for estimating the costs.   

As a result of the widespread use and power of Excel, we promote Excel estimating and have 
included a collection of takeoff and estimating workbook files for your use and review.  Many of our 
customers have already created their own Excel estimating template.  Others use the included Excel 
workbooks and customize these templates to fit their needs.  After installing the software, the Excel 
takeoff and estimating workbooks provided with BidPoint can be accessed from the BidPoint XL 
programs list. 

Introduction to BidPoint XL for paper plans 

BidPoint XL is a Microsoft Excel add-in program that allows you to measure, areas, lengths 
and count items, using a digitizer tablet while working in Excel.  Additional calculations can be 
performed with BidPoint XL through Microsoft Excel formulas and functions.  A concise audit trail is 
provided by automatically storing the digitized drawing into any Excel workbook cell and file.  In 
summary, BidPoint XL allows you to measure from paper plans while clearly organizing your takeoff 
in any Microsoft Excel workbook.  

Use your own Excel workbooks or utilize any of the Excel templates installed at C:\Documents and 
Settings\All Users\Documents\Vertigraph\BidPoint XL\examples.   

Requirements - Microsoft Excel version 97 or later is required. You need to be an administrator, have 
administrator privileges, or “Run As” the administrator.  

Minimum System Requirements:   Recommended System Requirements: 
Microsoft Windows Operating system   Windows Vista Operating System 
Microsoft Excel 2000+     Microsoft Excel 2003 or 2007 
2GB of RAM (XP) or 3GB (Vista)    3GB RAM (XP) or 4GB (Vista) 
800 x 600 Display Resolution.     1440 x 900 Display Resolution 
 

  



Installation of BidPoint XL 
 
Step 1 – Install BidPoint XL Software 
 

• Install BidPoint XL from the Vertigraph disc or go to http://www.vertigraph.com and click on the 
Download Evaluation 

• Complete the requested information and click the Submit at the bottom of the page.  
• Click on the Evaluation link next to BidPoint XL and select save.  Do not run the installation from the 

web page.   
• Save the BidPoint XL_Setup.exe to your desktop and then double click BidPoint XL_Setup.exe on 

to begin installation (make sure MS Excel is closed before starting the installation). Follow wizard 
instructions. 

 
Step 2 - Add BidPoint XL to Microsoft Excel 
  
For Excel versions prior to 2007 
 

• From a blank Excel workbook Click on the Tools menu; click Add-Ins; click Browse and navigate to 
C:\Program Files\Vertigraph\BidPoint XL folder. 

• Click on the file named BidPointXL.xla, and click OK.  This will place you back in the Add-Ins list, 
Click OK. 

• A BidPoint XL menu is added to the left of the Excel Help menu and a BidPoint XL toolbar is added.  
If the toolbar is not displayed, click on View, Toolbars in Excel to insure the BidPoint XL toolbar is 
checked. If the BidPoint XL menu is not active or grayed out, exit Excel and reopen to activate the 
BidPoint XL menu.   

 
If you have Excel 2007 
 

• From a blank Excel workbook Click on the Office button on the top left hand corner of Excel and 
Select Excel Options.  

• From the Excel Options Window Click on Add-Ins on the left. 
• Click the Go button at the bottom of the page next to Manager Excel Add-ins; this will display your 

Add-Ins list. 
• Click browse and navigate to C:\Program Files\Vertigraph\BidPoint XL folder and then Click on the 

file named BidScreenXL.xla, and click OK.  This will place you back in the Add-Ins list. Click OK 
• An Add-Ins Tab is added to Excel and under the Tab the BidPoint XL menu and Toolbar will be 

located. 
 
 

Tips and Important Information for Setup and Operating BidPoint XL with Excel:   

User specific setup options are located under Setup Menu at the Options Tab: 
 
Click on the                 to change to the recommended User settings for Version 5. This will place user specific 
Toolbars in the Takeoff Window along with your Style Palette for easy access. Additional Toolbars can be 
selected to display at the Takeoff Window under the Setup|Takeoff Window tab once you are more familiar 
with the BidPoint XL program. 
 
If you prefer the previous versions of BidPoint XL click on the                        under the Options Tab to return 
the Takeoff Window to the “Classic” BidPoint XL look and feel.  
 
BidPoint XL requires the installation of TabletWorks wintab driver.  Please contact GTCO at 800-344-
4723 or Interworld at 800-663­6001 for help. 
 

 

 



To setup button commands, go to the Setup command in the Digitizer menu.  Click the Cursor Style tab.  
Confirm that a check is next to the correct pointing device.  Click on the button to the right of “Set button 
actions to recommended values”.  Add sound to the buttons by clicking on the buttons tab and selecting the 
sound you would liked played when the button is pressed. 
 
To measure, click in an Excel cell, select the measurement command from toolbar (i.e. count, section length, 
continuous length or area), set scale and begin measuring with the zero (0) button on the 16 button cursor or 
the tip of a stylus pen.  To stop digitizing and return to Excel, press the 3 button on the sixteen button cursor. 
 
Important program information: BidPoint XL writes Cell Comments to each digitized cell as well as the “Default 
Cell” for a Workbook/Worksheet. Each Workbook should contain only 1 Default Cell which holds the “brains” of 
the workbook for BidPoint XL; the Default Cell is typically cell A1 but may be A2 or B1 or B2. Care should be 
taken to:  
 

a) Not delete the Default Cell of a digitized workbook/worksheet should you wish your digitized information 
to be saved for future reference; 

b) Use caution when copying cells/columns/rows/worksheets that contain digitized information and  
c) When recycling a used/digitized workbook/worksheet be sure that ALL digitized cells, along with the 

Default Cell from a previously digitized job are removed. 
 
All support documentation is installed with BidPoint XL in pdf format under C:\Program 
Files\Vertigraph\BidPoint XL\pdf. We recommend you go thru the short Tutorial document when starting your 
first takeoff to familiarize yourself with the basics of the program.    



The BidPoint XL Setup Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

If Use Drawing Names is 
checked, name and identify the 
drawing name as you digitize 

measurements. 

Fast Comment Scanning will speed 
up opening and closing large files 

with BidPoint cell comments 
present.  However, if checked, a 
runtime error 1004 could occur. 

Automatically check 
for BidPoint updates 
when they are sent 

 
Style Palette 

Select styles from a 
palette that appears on 
the left hand side of the 

takeoff window 

Information Bar 
Displays the following at top of 

takeoff window: 
• Name of loaded 

drawing 
• Style being used 
• File format 
• Current scale 

  

Auto Hide Style Palette 
Will automatically hide or 
display the Style Palette 

once the cursor is 
moved over it. 

Status Bar 
Displays information 
about the drawing 

found at the bottom of 
the takeoff 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Edit Keyboard Shortcuts 

BidPoint has numerous keyboard shortcuts assigned to many of the functions used during takeoff, such as Close 
Area or delete last point.  The keyboard shortcuts are already setup by default.  However, if needed, the user has 
the option to change those keyboard strokes. 

To change any of these keyboard shortcuts, click on Edit Shortcuts.  This button is found by clicking on the setup 
command from the BidPoint menu and then clicking on the Takeoff window tab. 

This shortcut editor displays (left) a list 
of all the actions that are assigned 
keyboard shortcuts.  
 
To change the combinations, select the 
action by clicking on the Shortcut Key 
column of the action. 
 
 

      

The change shortcut dialog appears. 
   
Press the desired key combination 
and it will appear in the edit box. Click 
OK to save settings. 
 

 

Tool Style 
Choose between the 
Classic look of the 
previous version of 

BidPoint or the new look 
of Version 5 

Draw Toolbar 
The following options 
are available on the 

takeoff window. 
 

Circle, Rectangle, 
Annotate, Highlight and 

Negative/Positive 

Show All Cells 
All of your digitized 
measurements are 
displayed as you 

measure into a new, 
blank cell.  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To change the action of 
each button: 

Click on the tab of the 
button to change and 

then click one of the 12 
actions 

Associate a sound with 
the button by selecting 
a sound from the list or 

by browsing for your 
own. 

 

Under the Cursor 
Style tab confirm that 
the correct pointing 

device has been 
selected. 

Set the digitizer buttons 
by clicking on the Set 

Button actions to 
recommended values. 



Styles Tab Window 
 
Create and organize measurement styles at the Styles tab.  If the Styles tab does not appear, click back on the 
options tab and confirm Use Styles is checked. 
 
Use Styles 
 
Styles refer to the way the takeoff is displayed on the screen and how it appears when printed.  To quickly 
identify different type of measurements or certain areas, there are five style characteristics available to make 
identifying those easier. 
 
Individual styles are organized into groups.  Groups may be defined in any logical manner.  Some users 
organize their style groups by project name, CSI division, material type, subcontractor trade or even color.  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Add 
Group 

Change 
title of 

caption 

Click Add 
Style 

Name the style; change 
the color, the style of 
pointer, the line width 
and style, and the fill 

pattern. 

If Show Style Palette is selected, 
the styles created are available 
while digitizing drawings by 
clicking on them.       

 In the Setup/Options tab you have the 
option to: 

1. Use Styles 
2. Share Styles,  
3. Change the default path of the 

Style File to a common location 
for sharing across multiple users 
and programs (ie.. BidPoint XL) 

4. Allow Writing – not Recommended 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Takeoff window is where measuring will be done and the drawing will display.  The Draw, Zoom, 
Information and Status Toolbars will appear in this window if Version 5 is selected in the Setup menu.   

 

If Styles has been selected under the Options and Takeoff tab and Show Style Palette, they will both 
appear in this window as well. Auto Hide Style Palette can be selected in the Takeoff tab under Setup 
to hide the palette when not needed. 

 

 

 

 

 

 

Style 
Toolbar  

 

Draw 
Toolbar 

Status 
Toolbar 

Information 
Toolbar 

Style 
Palette 



 

 

 

 

 

 

 

  

 

Count 

Counts items 
such as doors or 

walls 

Section Length 

Measures straight 
lines with only two 

points.  

Continuous Length 

Calculates the length 
of lines with multiple 

points and Perimeters 

Area 

Calculates 
Square 
footage 

Once a cell is digitized, the drawing name, 
takeoff type and digitized scale are 
displayed for you from the toolbar. Simply 
click on the cell to determine the digitized 
data it contains. 

Shortcuts and Tips: 

 

To record the perimeter length of an area, you can digitize the area takeoff in one cell and then move to a new, 
blank cell and select the Digitizer | Continuous Length command.  Click the green checkmark to accept the 
measurement.  The perimeter length of the last area measured is placed in that cell.  

 

Section lines are ideal for measuring straight lines. A section line will only have two points, a beginning of line 
point and an end of the line point.  If the count number is even, the next point you click will be the beginning of 
the next line. If the count number displayed is an odd number, the next point you click will be the end the line.   

 

Once digitized, you can retroactively go back and change the digitized scale of a single, or multiple, cells by 
selecting the cell/cells and selecting the Digitizer | Change Scale command. 

 



Print Drawing in BidPoint XL 

To view or print takeoffs in multiple cells, click on the first cell and hold down the Ctrl key on the keyboard as 
you click on other cells that have digitized data.  Once all the cells are selected, select Digitizer | Print Drawing  

  to display the Print Preview Window.  

  
The available print commands are found at the top of 

the Print Preview window. 

 

Style Legend 

Show Measurements 

Print to PDF format 

Print Scale 

 

Job data displayed at the bottom of 
the print out is customizable in the 
Digitizer | Setup under the Reports 

tab. 

 



 

 

 

 

 

 

 

 

 

 

 

 

The driver for the digitizer must first be installed in order for the digitizer to communicate to the computer, the 
driver has to be installed.   

Tabletworks is the driver for the GTCO board and a disk was shipped with the board.  If there is no disk available, 
please go to the GTCO website and download the latest driver. 

A few settings have to change in order for BidPoint to recognize the board. 

 

 
After installing Tabletworks, 
an icon is placed in the 
bottom right hand corner 
(next to the time). 

Double click on the icon.  
The control panel opens. 

Confirm that enable, mouse 
and wintab have a check 
underneath the headings. 

Click on the info tab.  Place 
a check next to specify a 
cursor and select the proper 
cursor. 

 

If you have a stylus, click on the 
stylus tab.  If you have a 16 button 
cursor click on the 16 button tab. 

This change is demonstrated with 
the 16 button tab. 

On the right hand side, to the left of 
the picture, click relative instead of 
absolute.   

Click Refresh List in the top right 
hand corner.  Save changes.  Then 
click OK. 

Drag the pointing device around the 
board; as long as the cursor on the 
screen moves smoothly, the driver 
is setup correctly. 

If you have any questions, suggestions or comments, please contact us at any time at 425-223-4311, 877-
902-2979 or www.interworldna.com.  Congratulations, you’re now ready for a real project with BidPoint XL. 



 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Leave as current user, if your login provides 
the privilege to install, and uncheck the box 

next to "Protect my computer..." 

“An access denied” error will occur if left 
checked.  Click ok to continue. 

Click “Yes” to begin installing the 
update. 

 

 

 

Updates are sent periodically to fix bugs and to update and upgrade software products.  These updates are done 
electronically via the web and notifications are prompted weekly when available for each product. When in doubt, you 
can also manually check for updates thru the programs menu option in MS Excel by clicking on the Check 
Updates option. To ensure the latest version is installed and your software continues proper operation, it is imperative 
that updates are performed.  The following will illustrate how to update the Excel Add-in Programs, BidPoint XL and 
BidScreen XL.  Your company's full serve must be up to date in order to receive updates and upgrades. 

If the Current User does not have 
the proper privileges to install, 
select "The following user" and 
type the proper administrator 

login.  Click ok. 

The Update Setup Wizard will begin. 

Click OK 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

  

 

 

You are prompted twice to Save Your 
Work and Close Excel.  

An error message will appear if 
the program is not closed.  Save 

your work, Close the program 
as usual and Click next. 

All updates are placed in this 
folder under the path file name. 
Click Next. 

 

Click Install. 



 

 

 

Your BidPoint XL and/or BidScreen XL software is now up to date. If you have 
any questions or need assistance please email support@vertigraph.com and 

include your Name, Company and Product Serial # located as follows: 

 

Click the Finish button to 
Complete the Update Wizard 

mailto:support@vertigraph.com�


Vertigraph Excel Tips & Tricks 

For BidPoint XL & BidScreen XL Software 
 

Excel 2007 Hotkeys/Keyboard Command Shortcuts Gone? 
 

To view your Hotkey/Keyboard Commands open MS Excel 2007 simply depress your “Alt” key on your 

keyboard. This will display the new keyboard commands.  

BidPoint XL users: 

New Hotkey/Keyboard Command setup from your digitizer Tabletworks Control Panel: 

 

 Scale (or Change Drawing) = Alt + X, C, 1 

 Count = Alt + X, C, 2 

 Section Length = Alt + X, C, 3 

 Continuous Length = Alt + X, C, 4 

 Area = Alt + X, C, 5 

 Section Length = Alt + X, C, 3 

 
 

 

 

 



Customize your Quick Access Toolbar with your favorite functions and go straight to what your looking 

for! 

 

 
 

 

From your Office Button   in MS Excel select “Excel Options”. 

This will prompt you to the Excel Options window where you should select the Customize menu on the 

left hand side. 

 

From the All Commands List select “Add-Ins” and then the Add button in the center of the page and 

select  “Customize Quick Access Toolbar” and then the Add button. This will add shortcut buttons to 

your Add-In list and your Excel Options right on your Quick Access Toolbar. 

 

 

 
 

Now add your Vertigraph software Menu and Toolbars right to your Quick Access Toolbar so they are 

always quickly accessible: 

 



From the Customize menu on the left hand side of the Excel Options select the Add-Ins Tab. Click on 

Custom Toolbars and click the Add button in the center of the page and then select Menu Commands 

and click the Add button in the center of the page and then click OK. 

 

 
 

 

 

For Excel 1997 – 2003 users: 
 

Please note this does not apply to Excel 2007.  To increase the size of your Toolbar buttons and/or 

change the width of a drop-down list box on a toolbar please perform the following: 

  

1. On the Tools menu in MS Excel, click Customize 

2. Make sure the toolbar you want o change is visible. 

3. With the Customize dialog box open, click the list box you want to change….. for example 

 

 on the Formatting toolbar. 

4. Point to the left or right edge of the box. When the pointer changes to a double-headed arrow, 

drag the edge of the box to change its width. 

 

 


